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CHAPTER 3	(	Exploring TriSpectives


Now that you’ve installed the software and taken a brief tour of its interface, it’s time to see what TriSpectives can do. This chapter showcases some of the exciting features that make TriSpectives unique. In the process, you’ll learn important techniques for working with IntelliShapes and models. 
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In this chapter


(	Creating a document


(	Working with a model


(	Using the camera


(	Colors and textures


(	Lighting


(	Using IntelliShapes


(	Combining IntelliShapes
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(	Creating a document� XE "Creating a 3D document" �


In TriSpectives, you work with 3D documents. These are the scenes and pages that hold your models. As you may recall from the previous chapter, a scene is where you build models and a page is where you combine models and other elements to create finished output.


Most examples in this manual involve model building, so most take place in a 3D scene. You can add a new scene to your WorkBook for each example. 


The last example in Chapter 5 combines models from previous exercises to create a collage. In the final example, you work on a page instead of in a scene.


Use one WorkBook for all the exercises in this manual. �
It’s a good idea to use one WorkBook for all the exercises in this manual. When you’re ready to create the collage in Chapter 5, all your models will be in one place.�
�
To begin the first exercise in the next section, create a blank 3D scene.


(	To create a new scene:� XE "Creating a new scene" �� XE "Scene:Creating" �


1	If you don’t have an open WorkBook, choose New from the File menu.


	TriSpectives displays the WorkBook Wizard. Follow the instructions on the Wizard to create a new WorkBook. If you aren’t sure whether you have an open WorkBook, look at the TriSpectives title bar. If a WorkBook is present, its name(or a generic title like “Book1”(appears in the title bar. 


2	From the Insert menu, choose Scene.


	You see the Insert Scene dialog box where you can specify the location of the new scene in the WorkBook.


3	On the Insert Scene dialog box, choose As New Scene in WorkBook.


TriSpectives displays a tab for the new scene. The tab appears at the bottom of the 3D document display area. At first, the tab has a generic name like Doc-1 or Doc-2. To change this name, right-click the tab and choose Rename from the pop-up menu. The dialog box that appears lets you specify a new name.
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(	Working with a model


A model � XE "Models:Definition" �is a 3D representation of a real or imaginary subject. In TriSpectives, you assemble models from IntelliShapes, intelligent 3D solids. For example, you might start a chess set by dropping a king on the board. Since the king is intelligent, it lands on its base. As you’ll see, IntelliShapes have other properties that make them very powerful.  


You can also import models from other sources such as a CAD program. These models don’t have component shapes; they’re one-piece objects.


Viewing a model� XE "Viewing a model" �� XE "Models:Viewing" �


The examples in this section use one of the models that comes with TriSpectives. You’ll see how to examine the model from different angles using the TriSpectives camera. Then you’ll learn how to add surface finishes and lighting effects.


Along with many other models, TriSpectives includes the king from a set of chess pieces. The examples in this section use the model king.


(	To begin working with the model king, drag his icon from the Collage catalog and drop it in the scene.


The next illustration shows the results.


�


King in 3D scene


Selecting a model� XE "Selecting a model" �� XE "Models:Selecting" �


Notice the white outlines along the surfaces of the model. These indicate that the model is the current selection; that is, the object of the next operation. TriSpectives automatically selects the first shape or model you drop in a 3D scene. For more information on selecting items in the display, see “� REF _Ref335727275 \* MERGEFORMAT �Editing models, shapes, and surfaces�” on page � PAGEREF _Ref335727275 �61�.


The Select tool� XE "Select tool" �� XE "Tools:Select" �


You can select an object, or clear the current selection, with the Select tool. Clearing a selection removes the outlines from a model or shape.


(	To remove the white outlines from the king:


��
1	Choose the Select tool if it’s not active.�
�
2	Click anywhere in the empty area around the king.


Once you choose the Select tool, every subsequent click selects an object or clears a selection. For practice, try selecting the king again.


(	To select the king, click anywhere on the surface of the model.


The white outlines appear again.


�
Once you’ve selected an object, you can perform a number of actions:


Drag it to a new location.


Change its size, color, or other properties.


Rotate it.


Change its elevation on a page.


Naturally, your changes aren’t permanent until you save the WorkBook that contains the object.


Getting the best performance from models


If you read Chapter 1, you may recall that TriSpectives users fall into two broad categories:


Product designers and other people who build models.


Graphic designers and other people who take finished models from various sources and use them to create artwork.


TriSpectives has separate work areas for each group. Model builders generally work in the 3D scene, which is where the example of the chess king takes place. People who work with finished models usually do so on the 3D page, which appears in Chapter 5.


Models can behave differently for the different kinds of TriSpectives users.�
By default, models behave differently in the two work areas. The difference involves the way a model appears when you first drop it on the scene or page. Since model builders need access to the IntelliShapes that make up a model, TriSpectives takes the time to�
�
create the model out of these components.


In the case of a simple model like the chess king, this time is so short that it isn’t much of a factor one way or the other. Complex models take longer to display, of course.


The overhead isn’t necessary in all cases. For graphic designers and other users who don’t care about the internal structure of models, TriSpectives can display them very quickly in simplified form. By default, this is how models appear on the 3D page. You can also get this kind of behavior in the scene.


�
(	To display models as quickly as possible in the 3D scene:


Choose Options from the Tools menu to see the Options property sheet.


Choose the Models tab on the Options property sheet.


Check the box labeled Drop as facet model in Scene.


By default, the box for the 3D page is already checked to allow quick display of simplified models. If a box has no checkmark, the corresponding work area displays models in full IntelliShape form with the accompanying overhead.


Choose OK.


Now, when you drop a model in the scene, it appears as a one-piece object composed of flat surfaces called facets instead of IntelliShapes. Facet models appear very quickly and offer all the flexibility that a graphic designer needs.


If you intend to work through the model building examples in this manual, it’s a good idea to leave the default behavior of the scene unchanged. If you aren’t interested in the model building examples, you can skip to Chapter 5 and learn about the 3D page. You can also use the above procedure to experiment with facet models in the scene.


(
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(	Using the camera


Working in a 3D scene is like working in outer space. There’s no up or down, no fixed point of view. The model is simply floating in space. 


Move the camera to examine a model from different viewpoints.�
If you want to see a model from a different location, you can change your viewpoint. That’s the function of the TriSpectives camera. The camera represents the eye of the viewer. By moving�
�
the camera, you can examine a model from any angle or distance.


�
The Orbit Camera tool� XE "Orbit Camera tool" �� XE "Tools:Orbit Camera" �


The Orbit Camera tool rotates the camera around an object.�
Use the buttons on the Camera toolbar to manipulate the camera. For example, the following instructions tell how to use the Orbit Camera tool to view the king from all sides.�
�
(	To move the TriSpectives camera in a 360(  circle around the model:


��
1	Choose the Orbit Camera tool.�
�
	The mouse pointer turns into a hand surrounded by an arrow.


2	Move the pointer into the empty area of the scene, somewhere to the left of the model.


3	Click and drag the pointer to the right.


	As you drag, the camera circles around the king. Note that the highlights on the surface of the model change as they would if you were circling a real object.


4	When you drag to the limit of the scene, release the button and repeat steps 2 and 3.


	You may need to repeat the process several times to make a complete circuit of the model.


Once you’ve finished this exercise, try experimenting with the Orbit Camera tool. Drag the mouse vertically and diagonally to see how your viewpoint changes. 


The Pan Camera tool� XE "Pan Camera tool" �


Use the Pan Camera tool to move in 2D.�
To move the camera in two dimensions, use the Pan Camera tool. It moves your viewpoint back and forth across a 2D plane in front�
�
of the model.


(	To move the camera to the left of the model:


��
1	Choose the Pan Camera tool.�
�
	The mouse pointer turns into a four-pointed arrow.


2	Move the pointer to the left of the model.


3	Drag the mouse to the right.


You can drag the Pan Camera tool in any direction. For instance, to move the camera vertically, drag the Pan Camera tool up and down.


The Zoom Camera tool� XE "Zoom Camera tool" �� XE "Tools:Zoom Camera" �


The Zoom Camera tool zooms the lens of the camera in and out.�
As the name implies, the Zoom Camera tool zooms the lens of the camera in and out. The effect is to make the model look bigger or smaller. Remember, though, that the size of the model remains�
�
constant. Only your viewpoint changes.


(	To zoom in on the king:


��
1	Choose the Zoom Camera tool.�
�
	The mouse pointer changes to a vertical arrow with a magnifying glass. The top of the arrow is bigger than the bottom, which indicates that you drag up to zoom in and down to zoom out.


2	Move the pointer under the king.


3	Drag the mouse upward.


	As you drag, TriSpectives zooms in closer to the model.


Try dragging in the other direction to zoom out.


The Fit Scene tool� XE "Fit Scene tool" �� XE "Tools:Fit Scene" �


The Fit Scene tool makes the model fill your field of view.�
The Fit Scene tool provides a variation on the zooming function. If your model extends beyond the range of the scene, the Fit Scene tool zooms the camera out to a point where the whole model fills�
�
your field of view.


(	To zoom the camera so the model fits the viewing area:


��
1	Choose the Fit Scene tool.�
�
	The mouse pointer changes to a box with arrows.


2	Click anywhere in the scene.


�
The Look At tool� XE "Look At tool" �� XE "Tools:Look At" �


The Look At tool examines one surface of a model.�
This tool offers a variation on the orbiting function. The Look At tool instantly changes your viewing angle so you’re looking directly at one surface of a model.�
�
For example, an architectural designer might want to look straight at the front of a model building. One click of the Look At tool is all it takes. In the current example, you can use the Look At tool to view the king directly from below.  


(	To view the base of the king from below:


1	Use the Orbit Camera tool to bring the bottom of the base into view.


��
2	Choose the Look At tool.�
�
	The mouse pointer changes to a pointing finger.


3	Click the base of the king.


TriSpectives moves the camera for a direct view of the base.


�


Effect of Look At tool


The Look At tool can be very helpful when you’re positioning the parts of a model. For example, if you want to position a button exactly in the middle of a control panel, it’s easier if you’re looking at the panel straight on.


The Window Zoom tool� XE "Window Zoom tool" �� XE "Tools:Window Zoom" �


The Window Zoom tool lets you define the viewing area.�
This camera tool provides a variation on the zooming function. When you draw a window in the 3D scene using this tool, TriSpectives zooms in to fill the window. This technique is useful�
�
when you want to work with a particular detail in a model.


�
(	To zoom in to fill a window:


��
1	Choose the Window Zoom tool.�
�
Using the mouse, draw a rectangular window in the scene.


Click at one corner of the rectangle and drag to the opposite corner. When you release the mouse, TriSpectives zooms the display to fill your window.


Other camera tools


In addition to the basic tools you’ve just seen, TriSpectives has three more for working with the camera. For more information on the Dolly, Walk, and Target tools, refer to “Using the Camera tools” in Chapter 2 of the TriSpectives User Guide.


Split screen views� XE "Split screen views" �


	TriSpectives has another useful feature for examining a model. You can divide the scene into two or more panes to see a model from multiple angles at once.


(	To divide the scene into two panes:


1	Right-click in the empty area of the scene.


	The pop-up menu for the scene appears.


2	From the pop-up menu, choose Vertical Split.


TriSpectives divides the scene into two parts, separated by a splitter bar.


�
�


Split view of scene


Any changes you make in one pane appear in both. For example, if you drop a texture on the cone in the right pane, the same texture appears in the left pane.


You can resize the panes by dragging the splitter bar. For instance, if you want to make the right pane bigger, drag the splitter bar to the left. The results look like the next illustration.


�


Results of dragging splitter bar


Notice that TriSpectives changes the perspective in each view to match its size. The apparent result is that big views contain big models and small views contain small models. As usual, though, it’s just your viewpoint that’s changing.�



The split screen lets you see a model from two angles at once.�
The advantage of the split screen view is that you can see a model from two or more angles at once. For instance, you might use the Orbit Camera tool to change your perspective in the right pane.�
�
You would see a display like the following.


�


Simultaneous viewing angles


If you need a third view, you can add one by choosing Horizontal Split or Vertical Split from the pop-up menu. Eventually, though, you’ll probably want to return to a single view.


(	To close one view in a split-screen display:


1	Right-click in the view you want to close.


2	From the pop-up menu, choose Remove View.


To continue with the examples in the next section, close any split screen views and return to a single image of the chess king.


(


(


(


(	Colors and textures� XE "Colors:Introduction" �� XE "Textures:Introduction" �


If you’re designing a real chess set, you want the pieces to have a distinct appearance. At the very least, you need to distinguish the black pieces from the white pieces. If you’re designing a specialty chess set, you might want pieces of marble or pewter.


�
In TriSpectives, it’s easy to give the surfaces of your model a custom appearance. Just drag a color or texture from one of the catalogs and drop it on the model. For example, suppose that you want silver and brass chess pieces. If you’re working with the chess king from the previous examples, it’s very simple to color him silver.


(	To color the chess king silver:


1	Open the Textures catalog by clicking its tab.


2	Drag the Silver 1 icon from the catalog and drop it on the model.


�


Model with silver finish


Try making a king of copper or brass. The Surfaces catalog has a Copper 1 and a Brass 1 entry. Compare the results by dragging each icon onto the model.


Textures


You can add realistic textures to your model.�
Along with colors, TriSpectives has catalogs with textures like cloth, wood, and stone. These catalogs also contains patterns, like circles�
�
and stripes.


If you’re creating a chess set for a high-class gift catalog, you might want pieces made of marble. You can find a texture called Gray Marble in the Textures catalog. If you drop this texture on the king, the results look like the following illustration.


�


Marble king


Naturally, some textures, like grass and clouds, wouldn’t make sense in the context of a chess set. They’re fun to experiment with, though.


Changing the scale of a texture� XE "Changing the scale of a texture" �� XE "Textures:Changing scale" �


Sometimes, a texture looks just right when you apply it to a model. In other cases, the features of the texture(like the grain in a marble texture or the fibers in a cloth texture(look too big or too small.


It’s easy to change the scale of the texture so that it’s appropriate for a particular shape or model. In the case of the model king, you can change the marble texture using the following procedure.


(	To change the scale of a texture on the model king:


Right-click the model to see its pop-up menu.


Choose Style Properties from the pop-up menu.


On the property sheet, select the Color tab if it isn’t active.


Choose the Settings button to see image projection settings.


Enter a new value in the Height or Width field.


If the texture seems too big, make the value smaller than the current entry. Enter a larger number to increase the scale of the texture.


Choose OK to apply the projection settings.


Choose OK on the property sheet.


Changing color and texture with property sheets� XE "Changing color and texture with property sheets" �


As an alternative to the catalogs, you can customize the appearance of an object using its property sheet. For instance, the next example shows how to change the color of the chess king to white.


(	To create a white king using its property sheet:


1	Right-click the king model to see its pop-up menu.


2	From the pop-up menu, choose Style Properties� XE "Style Properties sheet" �.


	The Style Properties sheet appears.


3	Choose the Color tab to see properties for colors and surface textures. 


	Notice the name in the Image File field. It’s the file that contains the marble texture that you selected in the previous section. Unlike textures, colors don’t require files.


4	Choose the Solid Color button to apply a uniform surface color instead of a surface texture.


5	In the color palette� XE "Color palette:Example" �, click the white square.


6	Choose OK to return to the scene.


During the course of this example, you probably noticed a number of intriguing options on the model’s property sheet. Along with color and texture, the property sheet lets you adjust bumpiness, reflection, and many other characteristics. 


For now, leave the king in his plain, white state. It’s best for showing off the lighting effects in the next section.


(


(


(


(	Lighting� XE "Lighting" �


Along with color and texture, light is an important tool for creating a realistic model. With TriSpectives, you can bathe your model in the warm daylight of a summer morning or the cool light of a winter moon. Use dramatic lighting to grab attention or subtle effects to emphasize texture or delicate features.


Lighting options� XE "Lighting:Options" �� XE "Lighting:Sources" �


TriSpectives lets you choose the number of light sources that illuminate your model as well as their color and intensity. In addition, you can adjust the way your model reflects light. Create a shiny apple or a dull baseball.


This section introduces lighting effects in TriSpectives. In the examples that follow, you’ll see how to train four lights on the chess king. You’ll experiment with colored light to produce dramatic effects.� XE "Displaying light sources" �


(	To display light sources in the scene with the chess model:


1	Right-click the blank background to see the pop-up menu for the scene.


2	From the pop-up menu, choose Scene Properties.


	The Scene Properties sheet appears.


3	Choose the Show tab to see items you can display in the scene.


4	Check the Lights box.


5	Choose OK to return to the scene.


The light sources become visible in the scene.


�


Model with light sources





��
Note: If you don’t see the lights, use the Zoom Camera tool to move back a bit. The lights should appear.�
�
There has been light in the scene all along. Now you can see where the light comes from. 


Once you display the light sources, you can move them, change their intensity or color, and try other effects. The following steps show how to change the color of one light source from white to bright red.� XE "Lighting:Changing colors" �


(	To adjust a light source so it produces a bright red light:


��
1	If necessary, click the Select tool to get the arrow-shaped mouse pointer.�
�
2	Click the light source closest to you.


TriSpectives outlines the light to show that it’s the current selection. You also see a line that indicates the direction of the light.


3	Right-click the light source to see its pop-up menu.


4	From the pop-up menu, choose Light Properties.


	The Light Properties sheet appears.


5	Choose the Light tab.


6	Click the red color box.


7	Choose OK to return to the scene.


TriSpectives bathes the model in red light.


�


Illuminated king


For dramatic lighting, repeat the above steps to color the remaining light sources. Make one light blue and the other one green.


To see the results of your handiwork, use the Orbit Camera tool. Take a 360( tour around the model. Notice how the lighting changes as you move.


Changing the direction of a light� XE "Lighting:Changing direction" �


Move a light source to change the angle of the light.�
You can also move a light source to change the angle of the light falling on a model. The results of this technique can be very dramatic.�
�
(	To adjust the angle of light falling on a model, click and drag the light source to a new location.


Try it with the chess model. Notice how the dark highlights on the chess piece change as you move the light.


Casting shadows� XE "Casting shadows" �� XE "Shadows" �� XE "Lighting:Shadows" �


�
By default, the light sources in TriSpectives cast a diffuse light with no shadows. You can add shadows for additional realism or a dramatic effect. Shadows are also good for emphasizing the structure of your model. For example, you might add shadows to a model tire to emphasize the grooves.�
�
(	To add shadows to your model:


Right-click in the scene to see its pop-up menu.


Choose Scene Properties on the pop-up menu.


Choose the Rendering tab on the property sheet.


Choose the Realistic Shading option.


Choose the Shadows option.


Choose OK on the property sheet.


Right-click a light source to see its pop-up menu.


Choose Cast Shadows from the menu.


Again, try it with the chess model. When you move the light source, the parts of the model cast shadows. If there was another object in the scene, you would see shadows on it as well.


(


(


(


(	Using IntelliShapes


� XE "IntelliShapes:Using" �Now that you have some experience working with models, you’re ready to start building them. The first step is to become familiar with the building blocks of models: IntelliShapes. To create a model in TriSpectives, you combine IntelliShapes to make a complex form. TriSpectives has several kinds of IntelliShapes.


Basic shapes


Some of the most useful IntelliShapes appear in the Shapes catalog. If you take a moment to browse the catalog, you’ll see that its contents fall into two categories.


3D solids� XE "3D solids" �� XE "IntelliShapes:Solid" �


3D solids are the simplest shapes.�
The simplest entries in the Shapes catalog are old friends from geometry class: the 3D solids. These include the cube, sphere, and�
�
other Euclidean shapes.


�


3D solids from Shapes catalog


For a particular model, you may not use a solid in its original form. It’s easy to change them. For example, it’s easy to create a rectangular block out of a square one by elongating it. For details, see “Modifying a shape” on page � PAGEREF _Ref337701652 �50�.





Holes� XE "Holes" �� XE "Holes:Introduction" �� XE "IntelliShapes:Holes" �


Hole shapes remove part of your model.�
Along with the solid shapes in the Shapes catalog, TriSpectives includes a number of holes. �
�
�


Holes


When you drop a hole on a shape or model, the hole removes a portion of its target. For example, a spherical hole carves a round bite out of a model. You might use a block-shaped hole to make a window in the wall of a model room.


Text shapes� XE "Text shapes" �� XE "IntelliShapes:Text" �


Add words to a model with Text shapes.�
Instead of abstract geometry, text shapes let you create 3D letters and words. There are several kinds of text shapes in the Text�
�
catalog.


�


3D text created with Text shape


This text has all the usual capabilities of 3D objects in TriSpectives. You can change its color, texture, lighting, and so forth.


�
Creating a shape� XE "Creating a shape" �� XE "IntelliShapes:Creating" �


In TriSpectives, every new model begins with a single shape. You drag it from the Shapes catalog into the scene, add other shapes, and then edit them to get the image you want.


To see how the process begins, start with an empty scene.


(	To add a new 3D scene:


Choose Scene from the Insert menu.


On the Insert Scene dialog box, choose As new scene in WorkBook.


Choose OK.


TriSpectives displays a blank 3D scene. At this point, you’re ready to work with shapes.


(	To create your first shape:


��
1	Choose the Edit IntelliShapes tool� XE "Edit IntelliShapes tool" �.� XE "Tools:Edit IntelliShapes" ��
�
Drag the Block icon from the Shapes catalog and drop it in the scene.


�


Block shape


All the basic skills that you learned earlier in this chapter work with shapes as well as complete models. You can change the color of a shape or use the camera tools to examine it from different angles. Usually, though, you’re more interested in modifying the shape to suit its role in your model.


�
Modifying a shape� XE "IntelliShapes:Modifying" �


A product designer might begin a model of a bracket with a block shape like the one in the Shapes catalog. Of course, since a block is not a bracket, the designer needs to modify the basic shape.


� XE "Handles" �� XE "IntelliShapes:Handles" �In TriSpectives, you modify a shape using its handles.


��


Block with shape handles


Handles� XE "IntelliShapes:Resizing" �


Use handles to expand or contract a shape.�
Each side of the block has a red handle that looks like a push-pin. The handles let you change the size of the shape by expanding or�
�
contracting it.


(	To change the size of a shape using a handle:


��
1	Choose the Edit IntelliShapes tool.�
�
Click the shape to select it.


Move the mouse pointer over the handle until the pointer changes to a grabbing hand.


Drag the handle in or out.


Try pushing the handle towards the opposite face of the block to make a rectangular shape like the one in the next illustration.


�
�


Result of dragging shape handle


The handles let you manipulate a shape’s sizebox. The sizebox is a frame that surrounds every IntelliShape and sets its dimensions. By dragging a handle, you move one face of the sizebox.


The sizebox isn’t obvious in the previous illustration since every face of the box conforms to a surface of the block shape. With some irregular or complex shapes, however, the sizebox defines an outer boundary but doesn’t follow every surface. Text shapes work this way, for instance.


The Anchor� XE "Anchor" �� XE "IntelliShapes:Anchor" � 


The Anchor shows where shapes join.�
Every shape has a unique handle called an anchor.�
�
��


Shape with anchor


The anchor shows the point where two shapes join. At the moment, you have only one shape, so its anchor doesn’t have any function. In a model with multiple shapes, however, the anchor is very useful. It acts as a reference point when you move one shape across the surfaces of other shapes.


�
Creating custom shapes from 2D cross-sections� XE "Cross-sections" �� XE "2D cross-sections" \t "See also Cross-sections" �� XE "Creating custom shapes from 2D cross-sections" �


If the basic Euclidean cubes and cones don’t meet your needs, you can create any 3D shape you need with these tools:� XE "Custom shape tools" �� XE "Tools:Custom shape" �� XE "IntelliShapes:2D-to-3D creation" �� XE "IntelliShapes:Creating from cross-sections" �


�


Custom shape tools


Custom shapes all begin with a 2D cross-section.�
Although their results are different, all of the custom shape tools use the same principle. To build a custom shape, you start by creating a 2D drawing or cross-section. Then you extend the cross-section�
�
into the third dimension by spinning, pulling, or some other technique.


� XE "Extrusion" �For example, when you pull(or extrude(a triangular cross-section like this:


��





�


2D cross-section


the result is a wedge shape, like this:


�


Result of extruding a triangle


When you spin a right triangle (one with a 90( angle) around its axis, the result is a cone. When you spin a 2D cross-section, the resulting 3D shape has an extra handle. It looks like one of the sizing handles, except its tip is square instead of round. This handle lets you modify the 3D shape by adjusting the angle of rotation for the initial 2D cross-section.


Creating a wedge from a cross-section


Of course, simple shapes like cones are already available in the Shapes catalog. You normally use the custom shape tools for more exotic specimens like these:


�


Custom shape


Before tackling an exotic shape, try your hand at a simple one to learn the basic techniques. The following instructions explain how to create a wedge shape out of a triangle. First, add a new 3D scene to your WorkBook.


(	To add a new 3D scene:


Choose Scene from the Insert menu.


On the Insert Scene dialog box, choose As new scene in WorkBook.


Choose OK.


TriSpectives displays a blank 3D scene.


Now that you have a place to work, you can draw the 2D image that forms the basis of the wedge.


(	To create the 2D cross-section:


��
1	Select the Extrude Shape tool.� XE "Extrude Shape tool" �� XE "Tools:Extrude Shape" ��
�
Click in the scene.


TriSpectives displays the Extrude Shape Wizard� XE "Extrude Shape Wizard" �. The first two parts of this wizard let you position a new shape relative to other shapes in the scene. Since this example creates a single shape, you can skip ahead.


Select Finish.


TriSpectives displays the Edit Cross Section dialog box and a 2D grid for drawing. The grid appears in 3D space with an arrow to show the direction of extrusion. If you want to look at the grid straight on, choose the Look At tool and click the grid.


�


2D grid


��
4	Select the � XE "Line tool" �Line tool.� XE "Tools:Line" ��
�
The pointer changes to a crosshair.


Click the intersection of two grid lines.


The point where you click becomes the endpoint of one diagonal line in the triangle.


Move the pointer down and to the left.


TriSpectives draws a line following your pointer.


Click the endpoint of the first line.


Your display should look like the following illustration.


�


Grid with diagonal line


Draw a second, horizontal line.


Click on the lower endpoint of the line you just drew. Then drag the pointer horizontally to the right and click again.


�


Grid with two parts of triangle


Complete the triangle.


Click again at the end of the line you just drew, drag the pointer up to meet the beginning of the first line, and click again. The next illustration shows the finished triangle.


�


Triangular 2D cross-section


Extruding the triangle into 3D


With the cross-section complete, the only job left is to extend it into the third dimension. 


(	To extrude the triangle, select Finish Shape on the Edit Cross Section dialog box.


TriSpectives extrudes the shape into 3D.


�


Extruded triangular cross-section


(


(


(


(	Combining IntelliShapes� XE "Combining IntelliShapes" �


� XE "IntelliShapes:Combining" �� XE "Models:Building from IntelliShapes" �Most models contain more than one shape. In this section, you’ll see how to assemble shapes into a model. 


Your first model


� XE "Models:Basic example" �To learn the basics of model building in TriSpectives, try creating a simple model from a few components. This section provides an example. You begin with one of the standard models that comes with TriSpectives:


�


Stairway model


Your goal is to add a walkway leading up to the stairs. The walkway is one of the basic IntelliShapes: the block. The next illustration shows the results of adding the shape to the model


�


Stairs with walkway


Before you start work on your first model, add a new 3D scene to your WorkBook. Choose Scene from the Insert menu. When TriSpectives asks where you want to place the scene, specify the WorkBook.


(	To add the block shape to the stairs:


Drag the Stairs model from the Collage catalog into the scene.


��
2	Using the Orbit Camera tool, rotate the model so that you can see the underside of the stairway clearly.�
�
�


Beneath the stairs


��
3	Choose the Edit IntelliShapes tool.�
�
From the Shapes catalog, drag a block into the scene and drop it on the surface underneath the stairs.


In step 4, note the green outline that appears on the bottom of the stairs before you drop the block. The block joins this surface. After you drop the block, the results look like the next illustration.


�


Stair model with block shape


Obviously, the block has a long way to go before it’s a sidewalk. You need to move it into position so it meets the corners of the steps, flatten it, and extend it in front of the stairs. The next steps show how. They introduce one of the most powerful tools in TriSpectives: SmartSnap.� XE "SmartSnap:Example" �


(	To reposition the block:


Move the pointer over a face of the block that’s parallel to a side of the stairs.


��


Preparing to drag block


Hold down the Shift key.


This action triggers SmartSnap. Now, when you drag the block, TriSpectives shows you when it’s lined up with the sides of the stairs.


Drag the block towards the side of the stairs.


When you see the green SmartSnap indicator, drop the block in place.


�����


Block in place


Use the SmartSnap technique to align the block with the back of the stairs.


Use the Orbit Camera tool to rotate the model so you have a rear view. Hold down the Shift key and drag the block towards the back of the stairs. When the SmartSnap indicator appears, drop the block.


���


��Block aligned with two edges


The block is aligned with two sides of the stairwell. Now you need to resize it so it occupies the stairwell’s entire width. Follow the instructions below.


(	To resize the block:


��
1	Use the Orbit Camera tool to rotate the model so you have a good view of the gap between the block and the side of the stairwell.�
�
Hold down the Shift key.


Drag the handle facing the side of the stairwell to extend the block to the width of the stairs.


Let SmartSnap help you match up the two shapes. Drag the handle until you see the green line along the edge of the stairs. 


�


Resized block


Make the block thinner.


Drag the handle at the top of the block until it’s a thin slab beneath the stairs.


Extend the block beyond the front of the stairs.


Drag the handle near the front of the stairwell. Extend the block so that it’s about twice the length of the stairs.


�


That’s your first model. Although it’s quite simple, it demonstrates a number of important features in TriSpectives. Most projects make heavy use of the sizing and positioning  techniques you saw in this example. The next chapter has examples that introduce new tools for building realistic models.


�
Editing models, shapes, and surfaces� XE "Editing models, shapes, and surfaces" �� XE "Models:Editing" �� XE "Models:Components" �� XE "IntelliShapes:Editing" �� XE "Surfaces:Editing" �� XE "Models:Levels of detail" �


The stair model contains two shapes. Furthermore, the shapes have separate surfaces. The block shape, for instance, has six surfaces.


�
You can work with an entire model or any part of it.�
TriSpectives lets you work at all three levels of detail. You can work with the model as a whole, a particular shape in the model, or one surface of a shape. You can even work with the edges and vertices�
�
where surfaces meet.


By default, TriSpectives assumes that you want to work at the model level. In other words, when you click something in the scene, you select the entire model unless you indicate otherwise. If you want to work at another level of detail, you have a couple of choices. You can:


Use the mouse.


Use the Selection tools.


The following sections cover these options.


Choosing parts of a model with the mouse� XE "Choosing parts of a model with the mouse" �� XE "Mouse:Selection techniques" �


You can select any part of a model using the mouse. The part you select depends on the number of times you click. 


First, make sure that the Selection tools are inactive. If one is depressed, click it to clear it. Also, if the scene shows any active selections (any highlighted objects) click in the blank area of the scene to clear them. Then click one of the objects in the scene.


Click once to select a model.


Click twice to select a shape.


Click three times to select a surface, edge, or vertex.


Note: Clicking twice is not the same thing as double-clicking. To select a shape, click once, pause, then click again.


After the third click, every subsequent click selects a new surface, edge, or vertex. To quit selecting these items, click in the scene outside of the model.


The mouse technique is useful in situations where you want to go back and forth between the different levels of a model. For instance, if you want to edit a shape, a model, and then a surface, the mouse technique is the best way.


Choosing parts of a model using the Selection tools� XE "Choosing parts of a model using the Selection tools" �


� XE "Selection tools" �If you want to work consistently at a particular level of detail, use the Selection tools. 


��
Choose the Edit IntelliShapes tool� XE "Edit IntelliShapes tool" � � XE "Tools:Edit IntelliShapes" �� XE "IntelliShapes:Editing" �to work with shapes. When this feature is active, you select every shape you click.�
�
��
Choose the Edit Surfaces tool� XE "Edit Surfaces tool" � � XE "Tools:Edit Surfaces" �� XE "Surfaces:Editing" �to work with individual surfaces. When this feature is active, you select every surface, edge, or � XE "Vertices:Editing" �vertex you click.�
�
As usual, clicking in the blank scene clears any selections.
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